Pinnacle Studio 14 Revealed
Supplement for Studio 15
If you have bought Studio 15 after buying the Studio 14 book, the following
information is taken from Chapter 7 of Pinnacle Studio 15 Revealed and deals
with the Archive/ Restore feature and the now correctly working Project Bin
function. I’ve included the whole chapter, with additional information about
Favourite Folders, Deleting projects, Finding Missing Media and Restoring Lost
Projects.
This chapter isn’t the only addition to Pinnacle Studio 15 Revealed, which
contains project checkpoints, more information about using Montage and
working in High Definition as well as many other additions and revisions.
The figure numbers have been left as they are in the new book.
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Studio 14 and 15 have one nice feature that helps you organise the Album so that
it holds the files you want to work with - Favourite Folders. Another feature in
S14 wasn’t completely implemented I so I didn’t use it much - the Project Bin.
In Studio 15 the issues with the project bin have been resolved, and a whole new
feature has been added - Archiving Projects. In this chapter, I’ll also look at
deleting projects, finding missing media and attempting to restore lost projects.

1.1

Setting Favourite Folders

Up until now, I have been advising you
to put all the assets that you might need
for a project into a specially created
folder. However, as you start producing
more projects, you might prefer to
organise yourself a little more than that.
I keep all my DV tape footage in a
folder marked DV Tapes, for example,
and I don’t really want to make a copy
of the file just for convenience,
particulary when the files are so big.

Figure 106 - Setting a favourite.

While dividing your video, photos and audio up into separate folders means they
are easy to locate, it’s very handy to get to the ones you use most quickly, so
whatever scheme you might decide on, I suggest you look at nominating some
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Figure 107 - Viewing your nominated favourites.

of them as your “Favourites”. Let us do this now, then I’ll show you how easy
it is to find them.
You should have the contents of the Project 1 folder on display in the video tab
of the album. If you haven’t, browse to the folder now using the “Select files…”
icon as before. Now use the Up Folder Arrow icon to display the Project 1 folder
and all the others in the same location, then right click on the Project 1 folder
itself.
Two options present themselves; Open Folder - the same as double clicking, and
Set as Favorite Folder. Check that option, and an orange star is displayed on the
folder itself.
I was a little underwhelmed when I first saw this feature, because the command
is in the singular, but then realised that you can have more than one Favourite.
You might want to browse your hard disc and find a few others to nominate.
Now use the drop-down selection list and choose “My Favorite Folders” and
your Album view will switch to show you all the folders that you have nominated.
You can select your favourites when you are in the Video, Photo or Music tabs
of the album.
Take a look at figure 107. Here I have played a small trick on Studio. You will
notice that the Folder icons are in fact shortcuts - the folders themselves have
not been moved. You will also notice that I have added some real assets. If you
has some files that you really use a lot, then you can use Windows to put them
in the Favourites location as well.
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This is because My Favorite Folders is actually a real Windows folder itself, and
you can put stuff in it using using Windows Explorer. The location in Vista and
Windows 7 is C:/Users/Your profile name/My Documents/Pinnacle Studio/My
Favorite Folders.
In Windows XP the path is C:/Documents and Settings/Your profile name/My
Documents/Pinnacle Studio/My Favorite Folders. In both cases, if your
operations system isn’t on your C: drive, you will need to look where it is installed.
The other nice thing about storing a few of your most commonly used files (or
copies of them) here is that as you switch between the Video, Photo and Music
tabs, only the relevant files are displayed.

1.2

The Project Bin

In UK English, a bin can be taken to be somewhere you put rubbish (a dustbin),
but in US English that’s a trash can (unless you are a Microsoft employee who
can’t use the same word as Apple for the Trash Can). In a film editing suite, you
might keep strips of film you are working hanging from racks or in bins. So the
Project Bin is somewhere you can keep assets for the project you are working
on. This is the same idea as I made you use with the Project 1 folder, but
integrates it into Studio. UK English users should not be alarmed when I suggest
they put something in the Bin.
Warning – in Studio 14.0, the project bin seems to forget it’s contents when you
close down Studio. There is a workaround for this, but is somewhat awkward,
so you might not want to use the Bin until you upgrade.

Figure 108 - The Project Bin open at the Videos tab.
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Here is how the feature works in Studio 15. With firstprojectc open, click on
the folder icon between the speaker and the project name top left of the timeline.
A new window pops up with four tabs across the top as shown below.
The first thing to note is that the Show timeline media/content check box is ticked.
As you haven’t actively added anything, that is why we can see our project1mp2
video file. Flip through the other tabs and you will see all the other assets.
Uncheck the box, and they all disappear from view.
This is a good way of checking exactly what assets you have in the project. If
you are still using Studio 14 and want to move your project to another computer,
this is a way to make a list of what your project actually includes.
Returning to the Video tab, and checking the box again, you will notice the Files,
Scenes and View controls that we are familiar with in the Video tab of the album.
If you are a fan of Details View you can see it here, and in Scenes/Comment
View you can still edit the comments.
I’d like to show you how to add other assets to the Bin now. In the next
chapter I’m going to use a map in the guise of a photo, so lets use that. You
will find the map in the same place as the other assets – the web site or DVD
data disc. It is called ukmap.jpg . Move it to the project 1 folder using
Windows.
In the Album, switch to the Photos tab and navigate to the Project 1 folder. Right
clicking on the map should bring up the context menu that includes the function
“Add to Project Bin”. Do this now. When you do so, a orange flag will appear
in the top right corner of the map’s thumbnail. If you bring up the context menu
again, you see the previous command has been replaced with “Remove from
Project Bin”. Obviously the orange flag indicates that the map is in the bin, so
open that now and switch to the
Photos tab.
Figure 109 - Add to Project Bin.
If you save the project, close
Studio and then reload the
program the map will have
disappeared from the bin, but
once you load the project again,
it reappears. (This is where the
Studio 14 version of this feature
falls down, by the way.)
What about all the timeline
objects that are only in the bin
because they are on the timeline?
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Well if you delete them from the timeline, you will lose them from the bin, so
Pinnacle provide a slightly different function in the context menu to turn the
temporary timeline items showing in the bin into permanent items regardless of
if you remove them from the project - the function is called Pin to Project Bin.
Let’s experiment with that feature by using the Audio tab of the bin. There should
be two items there - the music track project1music and the sound effect skid.
If you can’t see them, check you have the Show timeline media/content box
ticked. Use the right-click option to bring up the context menu and Pin the music
track to the bin, then delete the music and save the project under a different name
- I suggest bintest.
You might notice that the orange flag doesn’t appear on the thumbnails of the
audio files, because there are no thumbnail generated on which to display them.
Close Studio and reopen it, then load the bintest project, select the whole timeline
and delete it. Now when you open the Project bin, there should only be two items
there - the ones we pinned, the music and the map.
Titles and Menus are a special case. They appear in the Other tab, but although
you can add them to the bin from the Titles or Menu album tabs, if they have
appeared in the bin because they are on the timeline you can’t Pin them to the
project. The reason for this is because titles within a project are imbedded in the
project and you may have modified them, but there is no separate file existing
that the Bin can point to. To work round this, you need to open the Title or Menu
in the relevant editor and perform a Save as… operation. We will look at editing
titles and menus later on.
Another asset that will appear in the Other tab are Montages. Scorefitter tracks
are left out of the bin entirely.
If you own Studio 14, you must remember that you will probably lose any
items in the Project Bin when you close your project if they are not on the
timeline. The work round is to use the end of the timeline as a temporary
storage area for any assets you want to see in the bin but haven’t yet used in
the project. Some people report being able to get the items to remain if they
then pin them to the bin, but check carefully - I haven’t been able to make
this work.

1.3

Deleting Projects

I mentioned briefly in Chapter 1 that it was best to delete Studio projects from
within Studio itself. As the project format includes a hidden/locked folder, using
Windows for the task isn’t a good path to take.
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Figure 110 - The Delete Projects Window.

In the file menu you will find the Delete Projects… command. There are a few
features that might not be immediately obvious, so I’ll describe those as we go
about deleting the bintest project we made in the last section. Open the Delete
Project function and you will get a window pop up like figure 110.
First a word of warning - the Delete Projects function doesn’t give you a second
chance. The items don’t get put in the Windows recycle bin and what is more,
you aren’t asked to confirm your actions! So be careful. If you have a lot of
work invested in your current project, you might want to consider archiving it
as described in the next section - that way the Delete Projects feature can’t touch
it.
If your list of projects runs off the bottom, you can resize it so that they all fit by
dragging the edges of the box just like any other Window.
The first thing that isn’t immediately obvious to a casual Windows user is that
the list can be sorted according to the categories along the top line. For example,
if you click on the Created heading, the list will be arranged in the order that the
projects were created. Click again, and you will reverse the order, so you can
choose to have your latest, or your oldest, project at the top of the list.
If you sort the window with the latest project at the top, you should find bintest
easily. Click on the name in the first column and it highlight the name, ready for
deletion.

ORGANISING STUDIO - 7
The other helpful feature is that, like a Windows Explorer Window or the Studio
Album, the Windows selection shortcuts work, so you can highlight a number
of items at the same time by using CTRL-click, Shift-click of Shift-End or Home.
In the example above you can see that I have also highlighted another project.
Now all you have to choose is Delete or Cancel. Check that you only have the
projects you want to remove before clicking on Delete. When you do, the selected
projects are deleted immediately.
So, it is quite easy to delete your projects with a few simple keystrokes. As I said
before - take care!
One question sometimes asked is if the capture files are deleted as well. No, they
are not. In Studio 14 and 15 you have to find and delete them manually. All the
more reason for being organised when you select your capture options.

1.4

Archiving Projects

Studio 15 brings us the long awaited Archive feature. In earlier versions of Studio,
moving a project to another computer was very tricky because you had to move
all the media assets in the project separately. Also, if you had finished with a
project but wanted to retain the possibility to re-edit it, you ended up with lots
of media and projects cluttering up your hard discs.
The new feature puts a version of the project files and all the media you have
used into one folder that can then be transferred to a portable drive, data DVD
or data Blu-ray disc, either for transfer or long term storage.
You will find Archive Project in the Studio File menu. It is a pretty simple and
straightforward feature. There are a few points to note though.
If the project is large, you get a size and time estimate. The size estimate is
normally very accurate, but the time that the operation will take can be a great
overestimate. One project I recently archived consisting of DV-AVI files was
estimated at taking over an hour, but in reality it took less that 10 minutes.
The archive isn’t compressed - you can access the files inside without having to
restore the project. However further compression operations - using the Windows
Zip feature for example, don’t tend to reduce the size of the archive much at all
because video files with any form of compression already applied tend to be as
compressed as they can be.
When you archive a project, new copies of the media are generated inside the
folder. These have their filenames all in capitals.
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Restore Project is also available from the File menu. You need to find a .sta file
and when the project is extracted the date and time are added to the name. The
media files are then copied to yet another folder, with the new project name and
Media appended to the end.
The Archive is a great feature, but you don’t want to use it to back up multiple
versions of the same project; each archive will contain duplicate copies of the
same media, eating up disc space. What is more, when you restore the project,
yet another set of copies of the media are placed on your hard disc.
There are ways round this duplication of media, because it is possible to find any
media that Studio can’t locate, as we will see in the next section.

1.5

Finding Missing Media

If you have ever been been greeted with a project full of question marks, this
section will be of interest to you. I want you to be able to download the project
files from the website or the data DVD so you can get create firstprojectc without
having to make the project from scratch. Those files are quite small, but the media
takes up lots of space. The DVD and website could contain an archive of
firstprojectc, but you have already download the media files, so it would be
good not to have to download them again, or add another copy onto your hard
disc.
I’m now going to show you how the Missing Media dialogue function works in
Studio by getting you to load a project called firstprojectEDL3. It is a snapshot
of the Flight over
Figure 111 - The Find Media dialogue box.
Snowdon project
saved at the same
time as I created
the Checkpoint 2
EDL - you have
probably got this
saved
as
firstprojecta, but
I’ve changed the
name and added a
little Easter egg so
that you will know
it is a different
project.
Load the zip file
firstprojectEDL3
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Figure 112 - A project with no media.

from the data DVD or the website and put it somewhere easy to find - just copy
it to your C: drive root directory if you aren’t sure. Now right click and select
Extract All and let Windows choose the location. You will find the project files
alongside the zip folder.
Open the project in Studio. It isn’t going to find the media and you will be
presented with the dialogue box you see in figure 111. Let’s first see what
happens if you just close the box or click on Skip All, which you might do if you
weren’t sure what was going on.
Click on Skip All and you should be rewarded with a project full of question
marks. The only thing that shows up correctly is the little caption I added that
says “This is firstprojectEDL3”. We at least know that we have the right project
OK, let us have another go. Try to open the project again and this time pay
attention to the Find Media dialogue. In the filename is a clue as to what Studio
is looking for - the mpg file. Use the usual Windows controls to browse to the
Project 1 folder where you have placed the file, and then open it. Your reward
should be a fully populated timeline.
It is important now that you save the project so that it remembers the link you
have just created.
When a project gets complex, it will have more than one media asset, but Studio
will look for the others in the same location as you provide for the first one. If
your assets were scattered around your hard disc - perhaps the music came from
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My Music, the photos from My Photos - you will have to tell Studio about those
locations as well.
I’ve used firstprojectEDL3 here as an example, but you will find files for all
the projects in a folder called Projects on the data DVD and as a zip file on the
website.

1.6

Restoring Missing Projects

This is a subject that I have to admit having little experience of. I’ve probably
just been very lucky that I’ve never lost an important project. However, I’ve read
about it happening to many other people, and there are possible solutions.
Because at the time of writing I haven’t heard of the issue happening in Studio
15, there is hope that it has been cured, but the problem with working out how
to fix it is that it isn’t clear what causes it in the first place!
There are two common symptoms. You either get an error message that the
project’s associated folder is missing, or when you open the project, it turns out
to be empty. If it is full of question marks, refer to the previous section.

Figure 113 - Folder options.

Before you progress any
further, there is a
Windows setting that
should be checked to
avoid confusion. In
Windows Explorer find
the Tools menu and open
Folder Options. Switch to
the View tab and check
that Hide Extensions for
known file types is
unchecked, as shown in
figure 113. If it isn’t,
uncheck it now.
As I’ve said before, a
Studio project consists of
two files, the .stx part and
a (normally) locked folder
with the same name as the
project.
The
folder
displays as grey rather
than yellow and looks like
the one shown way back
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in figure 16. (It is possible that if you run a 64-bit operating system the folder
may appear yellow and not actually be locked, but as far as Studio is concerned,
it is!)
When corruption occurs, you often find that the locked project folder has become
unlocked. This should manifest itself as a normal yellow folder. Studio can't open
this folder via it's associated .stx file with the same project name and records it
as missing.
In some cases, Studio will automatically create a yellow backup project folder
using the same project name, but with .(2) added to the end of the name.
Unfortunately, it doesn’t also create an associated .stx file.
So - let us say you originally had a project called LotsOfWork. You saved this
project in the usual location. When you look in the location in which you saved
it using Windows Explorer there are two assets - LotsOfWork.stx and a folder
named LotsOfWork.
In Studio, when you go to open your project, you will only see the .stx files in
the Open Project dialogue box, unless you change the file type in the drop down
box shown in figure 114 to All Files (*.*)
Figure 114 - Making Studio display the project folders.
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When a project won’t open or opens as an empty file, the first step is to look for
LotsOfWork.(2). If you find this folder, don’t touch it! What you need to do is
rename the pointer file LotsOfWork.stx so that it has the same name as the
folder. You can do this in Windows Explorer or in the file dialogue within
Studio’s Open Project function if you have changed the view to All Files as
mentioned above.
In the above example, changing the name of LotsOfWork.stx file to
LotsOfWork.(2).stx might do the trick. Once you have performed the renaming,
try to open the renamed project in Studio. Don’t panic if it seems to be taking a
long time.
If there is no backup folder, you can attempt to create one, by adding .(2) to the
original Project folder - now yellow, not grey - with (in my example) the name
LotsOfWork so that it becomes LotsOfWork.(2)
Now perform the rename trick on the .stx file as described above. Fingers crossed,
when you now open the renamed project in Studio, you might have your project
back.
I’ve just been searching my hard discs, and indeed I have found a number of
folders with the .(2) text added. By copying a STX file and then renaming it to
the same name as the folders, I’ve recovered a number of projects I didn’t even
know were missing!
Your situation might be more complex than the example above, and it may not
be possible to save your work, but it is worth a try.
For more support, I suggest you visit the Pinnacle official forum, where you
may get help for the more complex cases.
I’d just like to express a word of thanks to those who discovered this fix, and
continue to help out the less fortunate who are normally tearing their hair out
by the time they get to the forum. In particular Peter Woods (Colour) has been
a virtual lifesaver for many people.

1.7

What have we learned from this chapter?

1.1
Setting Favourite Folders and placing files in that location.

1.2
Using the Project bin in Studio 15.
Project bin issues in Studio 14.
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1.3
Project deletion, including multiple selection.
Why care is needed when using the deletion function.

1.4
When to use the Archive feature
Disadvantages of using the archive feature for normal project
management.

1.5
How to find missing media.
How we can use the Find Media function to our advantage.
Loading book projects from the data DVD or website.

1.6
Possible solutions to restore missing or broken projects.

